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System Description 
The S4 Tech Wide Area Command and Control (WAC2) System extends the DOG Base Station 
capabilities to include a geo-referenced map based user interface along with graphical controls for 
radars, PTZ cameras, and fixed cameras. The software provides slew to cue capability in which radar 
targets or sensor detections can be rapidly assessed by automatically pointing a PTZ camera at the 
alarm location. An area scanning capability allows large flat areas to be scanned with video motion 
detection for wide area surveillance. A tour scanning capability allows the operator to select up to 128 
arbitrary points with individual focus and zoom levels, and then directs the camera to each of the 
selected points where it performs video motion detection. This allows a number of threat locations to 
be covered by a single PTZ camera.  

The WAC2 software application combines maps, grids, and icons with Spotter radars, DOG Base Stations, DOG 
standard cameras, DOG PTZ cameras, and DOG sensors. The software allows the user to select a default grid 
display or to import a map image in any standard image format.  Fixed camera, PTZ camera, sensor, and radar 
icons can be placed on the grid or maps and alarms are indicated both visually and audibly.  Radar targets are 
displayed with persistence tracks.   

The WAC2 System can be used with DOG radars, PTZ cameras, fixed cameras, and intrusion sensors.  
The following sections discuss how to set up each of these sensor types.   

Radar Interface kit 
The DOG Radar Interface Kit provides the capability to remotely power and connect to a DOG radar 
sensor and to display and configure the radar data on the base station laptop.  The DOG radar interface 
kit will power a Spotter radar out to 150m with a single (primary) CAT-5 cable and up to 500m using a 
second CAT-5 cable. The figure below shows the various components in the DOG Radar Interface Kit.  

 

Figure 1: Radar Kit with Military Grade Case 
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Each case is identified by a decal just above the handle as shown in the figure below. 

 
Figure 2: Radar Interface Kit Identification Label 

 

Connecting the Radar to the Base Station 
Begin connecting the Radar to the Base Station by removing the weatherproof connector gland for the connector 
labeled J1.  Run a CAT-5 cable through the weatherproof gland and plug the RJ-45 connector into J1 as shown in 
the figure below.  If the cable distance being run from the radar to the base station is 125m or less in length then 
J1 is the only connection that needs to be made between the radar and the base station.  In this case it is 
extremely important to put a small piece of CAT-5 cable into the other cable gland to insure an environmentally 
tight seal.   

 

***WARNING***  DO NOT REMOVE THE WEATHERTIGHT CONNECTOR ON THE BOTTOM OF THE RADAR HEAD. 
CONNECTING  THE PRIMARY OR SECONDARY CABLES DIRECTLY INTO THE RADAR MAY DAMAGE THE RADAR.   

 

 

   

Figure 3: Radar Remote Module CAT-5 Primary Connections (125m or less) 
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When connecting the Radar to the Base Station over distances betweem 125m and 450m a second CAT-5 cable 
needs to be run and connected to the J3 connector to extend the operational capabilities as shown in the figure 
below.   

***WARNING***  DO NOT REMOVE THE WEATHERTIGHT CONNECTOR ON THE BOTTOM OF THE RADAR HEAD. 
CONNECTING  THE PRIMARY OR SECONDARY CABLES DIRECTLY INTO THE RADAR MAY DAMAGE THE RADAR.   

 

Figure 4: Radar Remote Module CAT-5 Auxillary Connections (125m -450m) 

Once the CAT-5 cables have been plugged into the the Radar Remote Module the other end of the cables can be 
connected to the Radar Base Station.  The primary cable that was plugged into connector J1 on the Radar must be 
plugged into the connector labeled J6 on the Base Station.  If second cable is plugged into connector J3 on the 
Radar then connect the other end of this cable into the connector labeled J7 on the Base Station.  

 

   

Figure 5: Connecting Radar Remote Module to Base Station 

 



S4 Tech Inc  

  6 

It is highly recommended to attach a grounding wire to the grounding post on the Radar Base Station and clamp 
the other end to a to a large metal structure, pipe, or electrical outlet ground as shown in the figure below.  This 
will help to protect the hardware and user against lightning.  Next plug in the 40Vdc adapter into the J5 connector 
on the Radar Base Station to power up the radar.   

 

   

Figure 6: Powering Up the Radar Base Station  

 

With the Radar and Radar Base Station powered up connect a CAT-5 cable to any of the connectors labeled J1-J4 
on the Radar Base Station to the Base Station computer. 

   

Figure 7: Connecting Radar Base Station to Computer 
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Connecting the Optional Radar GPS 
To connect the optional GPS to the DOG Radar first plug in the GPS connector into the Radar as shown in the 
figure below.  The GPS contains a magnetic strip that will allow it to easily attach to the top of the radar and stay 
without any mounting hardware. 

 

 

   

Figure 8: Connecting GPS to the Radar 

 

Software Connection and Configuration of the Radar 
Once everything is properly connected, power up the system. The Radar takes approximately thirty seconds to a 
minute to fully power up and initialize. Use the Base Station laptop to open up a Google Chrome web browser by 
double clicking on the Google Chrome icon as seen in the figure below.  The IP address of the Radar is set to 
192.168.0.20 and can be seen on a decal on the radar case as seen in the picture below.   

 

Figure 9: Radar IP Address Decal 
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The Chrome browser is set to automatically load the Radar’s configuration page when it is run.  The IP address of 
the Base Station laptop is usually set to 192.168.0.3 or 192.168.0.13.     

 

   

Figure 10: Connect to Radar with Chrome Browser 

 

QuickStart Configuration 
Whenever a Radar is installed in a new location it is important to configure several radar settings.  Click on the 
“Quick Start” tab at the top of the web browser to see the screen in the figure below.  The Environment: Wind 
Speed setting is used to help eliminate false alarms generated by the wind blowing trees and other objects within 
the Radars field of view.  Increaseing the environment wind speed reduces the sensitivy of the Radar.  It is 
recommended to start with a slow wind speed and gradually increase the setting until all false alarms stop. 

The Orientation: Azimuth Setting is critical to properly aligning Radar’s angle relative to north. Type in the angle 
(in degrees) relative to true north that the radar is pointing.   Note: If the S4 Tech WAC2 map based software is 
used then this is done automatically.  

The Location: Lat, Long, Elevation setting is critical for determing the exact location of the Radar.  If the GPS 
module is connected to the Radar then the location information will automatically be uploaded to the software.  
The location information can also be manually entered should it be necessary.  Note: If the S4 Tech WAC2 map 
based software is used then this is done automatically based on the location (lat/lon) of the point that the user 
clicks on in the map.  

Once all of the Radar settings have been properly configured it is important to click on the “Save” button at the 
bottom of the webpage to save all of the settings. Note** Consult the Radar’s user manual for a more detailed 
description of these settings as well as many other non-critical settings. The manual is available via the browser. 

 



S4 Tech Inc  

  9 

 

Figure 11: Radar Software Quickstart Config Tab 

 

Network Configuration for the Radar 
As mentioned above, the  IP address of the radar is set to 192.168.0.20 and the subnet mask is 255.255.255.0 as 
seen in the figure below.  If for some reason this address were to be changed or corrupted, the user can connect 
to the default ip address of the radar at 169.254.254.254. In this case the Base Station laptop must be set to the 
same subnet 169.254.254.xxx. 

 

Figure 12: Radar Software Network Config Screen 



S4 Tech Inc  

  10 

Viewing Radar Data 
Once the Radar has been properly setup click, on the “Tracker” tab in the upper right hand corner of the 
webpage.  The Radar’s Tracker Display page will open up in a new browser window as shown in the figure below.   

 

Figure 13: Radar Tracker Display Screen 

 

The grid display shows the range and angle contours along with the radar personnel detection pattern. Target 
tracks are displayed as unique colored squares with an adjacent track ID as seen in the figure above. The range 
and bearing associated with the track ID are displayed in a matching color in the upper left or right corner of the 
grid. The display can be configured by clicking on the SpotterRF icon in the upper left corner of the grid. When 
clicked on, the icon expands into the high level configuration menu options as seen in the figure below.  Click on 
each option to set up background color, line and text sizes, grid labels, target display options, etc.  Mask zones 
can also be set up so that no detections occur in those areas.  

   

Figure 14: Display Config Menu 
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Configure the Radar Outputs for the  Wide Area Command and Control Software 
The first step in running the S4 Tech WAC2 application is to configure the radar to send target data to that 
application.  This is done in the Outputs tab of the radar browser page as seen in the figure below.  Use the 
settings in the figure to set up radar target data communication to the laptop running the S4 WAC2 application.  
Make sure that the IP address is set to match that of the laptop.  Note: If the S4 Tech WAC2 map based software 
is used then this is done automatically when the radar is added.  

 

 

Figure 15: Configure the Radar for S4 C2 Software 

 

Note** To check that the rada is outputting target data open another Google Chrome browser page and enter 
the following url: 192.168.0.20/tracks.json.  You will see the latest serial message sent by the radar in the browser 
window.  

 
PTZ Wide Area Scan System 
The PTZ Wide Area Scan System is used to scan large flat areas or to check a number of seleced points around the 
threat perimeter.  The wide area scan system hardware consists of one or more DOG high performance low light 
PTZ cameras (with or without the thermal camera option) and a PTZ Network Interface Unit as seen in the figure 
below.  
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Figure 16: PTZ Scan Area Equipment 

The PTZ Wide Area Scan System can perform an Area Scan that utilizes video motion detection to scan a large 
clear flat area looking for any movement.  When movement is detected an alarm is generated and the user can 
assess the alarm via the camera and take control of the camera if needed.  The Wide Area Scan System can also 
perform a tour scan in which the operator points a PTZ camera at up to 128 points along the perimeter and inputs 
each point into the software including zoom and focus levels for that point.  The tour scan software will then 
direct the camera to each point and enable motion detection for a user specified number of seconds before 
continuing to the next point.  If a video motion alarm is received the camera will dwell on that point for a user 
specified number of seconds before moving on.   

 

Setting up the PTZ Wide Area Scan System 

     

Figure 17: PTZ Connection 
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Network Configuration for the PTZ Camera 
The default IP address of the PTZ camera is set to 192.168.0.10:10001 and the subnet mask is 255.255.255.0 as 
seen in the decal on the unit in the picture below. If additional PTZ cameras are provided, their default IP 
addresses will be indicated on the decal.  The WAC2 application has the PTZ Cameras coded internally so there is 
currently no need to configure these parameters.   

 

Figure 18: PTZ Adapter IP Address 

Running the S4 C2 Application 
Once the radar outputs have been configured to run the S4 Tech Command and Control application double-click 
on the S4 Command and Control desktop icon as indicated in the figure below to launch the application.  

 

 

Figure 19: Start S4 C2 Software 
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The S4 Command and Control application will open up in a new window.  Note** If no DOG Base Station or PTZ 
camera are connected to the laptop then it may take a minute or two before the application opens as it searches 
for connected devices. Once open the user can click on the Help menu on the upper left to see a full set of help 
instructions for the application. The main page of the help menu is seen in the figure below.  

 

 

Figure 20: S4 C2 Help Document 

 

The Map Tab 
The figure below shows the Map tab of the application.  It contains a default 500m grid with a radar, fixed 
camera, and PTZ camera placed on the grid. The radar personnel detection pattern is shown as  yellow oval  and it 
points in the direction of the user entered bearing for the radar. The PTZ and fixed camera fields of view and 
shown as green and blue fans respectively, and also point in the direction of the cameras.  Motion detection or 
sensor alarms from a connected DOG Base Station DVR will cause the fans to turn red and flash along with an 
audible tone that can be disabled. Video from the corresponding alarms can be seen on the DVR under that 
camera’s channel. The virtual joystick in the upper right corner of the page will control one or more connected 
PTZ cameras.  
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Figure 21: S4 C2 Map Tab with 500m Default Grid 

 

 

Changing or Loading a Map 
The default grids or maps can be changed by right clicking anyware on the map or grid graphic and using the pop-
up menu as seen in the figure below. Maps can be added with the Import Map option or removed with the 
Remove Map option. See the Help menu for more details on this process. The default grid can be changed to a 
250m or 1000m grid or to a default map by selecting the Swich Map option in the popus menu and then selecting 
the desired option in the submenu. Cameras and radars are added to the map using the pop-up menu also as 
seen by the options in the figure below.  
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Figure 22: Main Config Menu on Map Tab 

The default map option is shown below. 

 

 

Figure 23: Default Map 
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Adding a Radar 

Add Radar 
• Right click on the radar position on the Map, select Place Radar Here from the context menu 
• On the Place Radar dialog, enter the Name, Bearing, Radar IP address, and select the Radar type from the 

Type dropdown box.   
• The Launch Web Interface button will open a browser window that will allow configuration of the various 

radar parameters.  

 

Figure 24: Add Radar to Map 

 
• Click Ok, and the position and bearing settings are automatically uploaded to the radar.  The radar icon 

with radar coverage pattern will be displayed on the map and the radar target subscription information 
will be automatically entered into the radar.   

Remove Radar 
• Right click anywhere on the Map, select Remove Radar from the context menu 
• On the Remove Radar dialog, select the radar you like to remove 

 

Figure 25: Remove Radar from Map 

 
• Click the Remove button 
• Click the Close button 
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Configuring the Radar Position 
It is important that the radar bearing and position on the map or grid correspond to the Orientation [azimuth 
angle] and Position [Latitude (Lat),Longitude (Long)] shown in the radar browser or the targets will not display in 
the right locations.  The radar bearing and lat/lon are automatically entered by the user when the radar is first 
placed onto the S4 C2 map.  The bearing can be verified by the direction that the radar pattern is pointing as seen 
in the figure below.  The user should verify that this matches with the Orientation:Azimuth Angle settings on the 
Quickstart tab of the radar browser.  The radar location on the map is determined by where the user clicks the 
mouse before right clicking the pop-up menu to add the radar.  The Lat/Long location of the mouse click can be 
seen in the bottom right of the screen as shown in the figure below. The user should verify that this matches with 
the Position: Lat/Long settings on the Quickstart tab of the radar browser. 

 

 

Figure 26: Radar Bearing and Position Verification 

 

The Cameras Tab 
The cameras tab is the where fixed cameras, PTZ cameras, and DVR units are set up in the S4 C2 application as 
seen on the main tab in the figure below. For each component that is added, submenus will pop up and the 
appropriate parameters must be entered by the user.   

PTZ Cameras 
PTZ cameras have name, IP addresses, TCP ports, DVR channel, and scan area parameters that must be entered 
as seen in the figure below.   
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Figure 27: Add PTZ Camera 

 

Once a camera has been added it can be placed on the map or grid by right clicking the mouse on the desired 
location, selecting Place a PTZ Camera,  and entering the parameters in the dialog box as seen below.  

 

 

Figure 28: Place PTZ Camera on Map/Grid 
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Fixed Cameras 
Fixed cameras have name, DVR, and DVR channel parameters as seen in the figure below. 

 

Figure 29: Add Fixed Camera 

Once a camera has been added it can be placed on the map or grid by right clicking the mouse on the desired 
location, selecting Place a Fixed Camera,  and entering the parameter in the dialog box as seen below.  

 

 

Figure 30: Place Fixed Camera on Map/Grid 
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DVR Configuration 
To connect to a DOG Base Station DVR enter the IP address of that DVR and the number of channels that unit has 
(4 or 8).  

 

Figure 31: Camera and DVR Configuration 

 

The DVR should be configured through the Event Menu - Alert Notification Submenu to send alarms to the 
WAC2 application (IP Address 192.168.0.3 Port 9999). When an alarm is received by the DVR the corresponding 
camera icon will flash red on the map.  

   

Figure 32: DVR Alert Notification Configuration 
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Using the Map Interface 
The map interface has several capabilities described below that are graphically controlled.  

Lat/lon Position 
Left click a point on map, the lat/lon position will be showed on the lower right corner of the screen. 

Distance and Bearing Measuring 
To measure the distance and bearing between two points on the map, left click the starting point and then drag 
the mouse to the end point. A yellow line will be drawn on the map following the mouse movement. The distance 
and bearing are showed on the lower right corner of the screen, as showed in the following figure. Releasing the 
mouse, the lat/lon of position of the end point will be showed as well. 

 

Figure 33: Distance and Bearing Measurement 

 

Slew to Cue 
Slew-to-cue capability allows the user to ctrl-click on a point on the grid or map and cause the PTZ camera to pan 
to that spot.  This is typically used in conjunction with radar targets or sensor/camera alarms to visually assess the 
situation.   

 

Automatic Radar Target Tracking 
This capability allows the user to shift-click on a radar track on the grid or map.  The PTZ camera will slew to the 
track location and as long as the radar track remains active, the PTZ camera will follow the target.  Shift-click on 
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one of the orange radar tracks in the figure below and the PTZ camera will slew to that target and continue to 
follow the target as long as the track remains active.  

 

Figure 34: PTZ Target Tracking 

Video Display 
To display live video on the computer monitor select a camera by placing the cursor over that camera's field of 
view (the triangle) on the grid or map and right clicking to get the menu shown below.  

 

Figure 35: Select Live Video Source Camera 
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Select the camera and a window showing the camera's live video will open on the screen.  You can resize the 
window and drag and drop it anywhere on the screen.  This can be repeated for all the cameras on the map.  

 
Figure 36: Display Live Video on Map 

PTZ Wide Area Scanning Function 

Enter an Area Scan Profile 
An area scan will cause the PTZ camera to scan a user defined arc (1-360 degrees) in user defined degree 
increments and with a user defined PTZ tilt angle and stare time (how long the camera stops and stares with 
motion detection enabled at each increment).  These parameters are set up using the Step and Stare by Angle 
PTZ parameters.  The paramter entry dialog box is reached by adding a new PTZ camera (Add) or editing an 
existing PTZ camera (Edit) as shown in the figure below.   

 

Figure 37: Enter Scan Area Profile 
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Enter a Tour Scan Profile 
A tour scan profile causes the PTZ to cycle through a set of user defined points in an arc from 1-360 degrees.  The 
camera will stop and stare with motion detection enabled at each point for a user specified amount of time.  Each 
of the tour points is set by using the virtual joystick to pan and tilt the camera to the desired location (using the 
monitor to verify the image).  Once a desired point is reached the desired focus and zoom levels may also be set 
using the virtual joystick interface.  At this point the preset may be added to the tour by selecting the Presets 
checkbox and clicking on Add as seen in the figure below.  

 

Figure 38: Enter Tour Scan Profile 

Ener the name of the preset along with a stare time (how long the camera will dwell on that spot with motion 
detection enabled) as seen in the figure below.  The preset point will then be visible in the Preset Tour list.  
Continue adding points until the tour is complete.  Select Start Tour to start the Tour Scan.  

 

Figure 39: Enter Tour Scan Preset Point 
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Exit the Application 
To exit the S4 C2 application, click on the File menu and then select Exit or simply click on the X in the upper right 
corner of the application window and the application will shut down.  

Troubleshooting 
 

1. The radar unit does not appear to power up.   It may take several minutes for the data link to establish a 
connection with the radar. Also check the length of the CAT-5 cable connecting the radar.  If it is over 
100m then two CAT-5 cables are required out to 300m. 

 

2. The radar does not appear to connect to the system.  Open the Google Chrome browser window on the 
Base Station Processing Module and type in http://192.168.254.254 to connect to the radar.    

 

Contact Info/Tech Support 
For questions or support please see our website at:   www.s4-tech.com or contact: 

admin@s4-tech.com, 703-956-9088 

http://192.168.254.254/�
http://www.s4-tech.com/�
mailto:fdeangelis@s4-tech.com�
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